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Don't panic! Try our techniques to 
salvage your corrupt document

Your Word document was fine the last time you used it, but this time 
it’s full of gibberish. Before you curse at your computer, first close 

the document (but don't close Word). Choose File | Open. If the Files Of 
Type dropdown list is set to Recover Text From Any File (*.*), breathe a 
sigh of relief, change that setting to Word Documents (*.doc), and then 
open the pristine file.

But what if Recover Text From Any File wasn’t the problem? Maybe 
you could access only part of the file. Maybe the text was correct, but the 
formatting went haywire. 

Recover a corrupt file
If it's your lucky day, you can successfully recover a corrupt file. And, 
sometimes, even if you can't recover the entire document, you may still 
be able to salvage some of it. Here are some ways you can recover a file:
• Open And Repair (2002/2003). In the Open dialog box, select the file, 
then choose Open And Repair from the Open dropdown list, as shown in 
Figure A.
• Reboot.  Perhaps the problem is systemic. Close everything, then shut 
down and restart Windows. Open Word and try to open the document.

• Try a different 
computer. See 
if the file will 
open correctly on 
another comput-
er. If it does, the 
problem is with 
your system, not 
the file.
• Open a back-
up. If you previ-
ously made 
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a backup copy of your document, or 
if the Always Create Backup Copy 
check box is selected on the Save tab 
of the Options dialog box, as shown 
in Figure B, you can find and open 
the *.bak copy of the file. 
• Save to/from HTML.  Choose File 
| Save As Web Page. Be sure that the 
Save as type dropdown list is set to 
Web Page (not Web Page, Filtered, 
which strips out formatting such as 
page numbers and headers and foot-
ers). Note the Save In location and 
the .htm extension, and click Save. 
Now close and reopen Word, open 
the *.htm version of your file, and 
save it back in Word’s *.doc format.

Switching to/from the HTML for-
mat forces Word to completely redo 
the file’s underlying structure. That 
usually removes problematic code 
while preserving most, if not all, of 
the formatting and page layout.
• Open in Notepad.  Open the Win-
dows Notepad accessory and try to 
open the document there. If you suc-
ceed, much of the formatting should 
still be intact.
• Work with a “clean” Normal dot.  
Choose Tools | Options, then click on 
the File Locations tab to find the loca-
tion of Word’s Startup folder. Close 
Word and use Search and Explorer to 
find and rename all copies of Normal.
dot to Normal1.dot, Normal2,dot, etc. 
When you next open Word, it will gen-
erate a “clean” version of Normal.dot. 

Then navigate 
to Word’s Startup 
folder and move 
any *.dot or *.wll 
files temporarily to 
another folder. Now 
open Word and try 
to open the file. 
Whether you suc-
ceed or not in open-
ing the file, be sure 
to close Word and 
undo/restore any 
system changes you 
made in trying to open the file.

Save paper with the Shrink To 
Fit feature 

You may find that sometimes, objects 
such as graphics, text boxes, or tables 
extend so low on a page that they cre-
ate an additional page. Because there 
is no text line below the box, you can’t 
remove the extra page. 

The handiest quick-fix is the Shrink 
To Fit feature. Whether you’re creat-
ing a document that must adhere to a 
certain page count, or you just want 
to save a tree, the Shrink To Fit feature 
can help you quickly condense a docu-
ment that’s running a few lines long.
1. Select File | Print Preview from the 
menu bar. As an alternative, click the 
Print Preview button on the Standard 
toolbar. 
2. In the Preview window, click the 
Shrink To Fit button on the Print 
Preview toolbar, as shown in Figure 
A. If your document’s font sizes offer 
enough wiggle room, Word automati-
cally adjusts them proportionally to 
reduce the document length by one 
page. 
3. If you’re unhappy with the results, 
simply press [Ctrl]Z to undo the 
action.
This technique should work well 
with documents containing tables, 
but depending on your document 
layout, it may not work with all of a 
document’s text boxes. 

To squeeze a text box onto a single 
page, your best bet is to size and posi-
tion the text box so that it doesn’t 
exceed your page and margin dimen-
sions, then resize the font size of the 
text box’s contents so that it all fits 
within the text box’s visible area.

Corrupt documents (cont. from page 1)

QUICK TIPSQUICK TIPSQUICK TIPS
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Figure B

Salvage file parts
Sometimes you can open the file, but 
not access everything in it. Then your 
goal shifts to salvaging as much of 
your document as possible.
• Try to isolate the problem.  Perhaps 
a “Based on” style is missing, or Auto-
Correct or AutoFormat As You Type 
has some unusual settings. Try deleting 
section breaks. Check for any AutoOpen 
or AutoClose macros (or viruses) that 
are making changes.
• Paste “good” content to a new file.  
Press [Ctrl+A] to select everything, 
then press [Shift+Left Arrow] to dese-
lect the final paragraph mark, which is  
also the final section mark—that mark 
often contains the source of a docu-
ment’s corruption. Copy the selection 
and paste it into a new document.

Or, copy and paste a few paragraphs 
at a time to a new document until 
you’ve isolated the problem paragraph. 
Try selecting everything in that para-
graph except its paragraph mark and 
copying it to the new document.

For a long document, try copying 
just half of the file to a new file. If the 
top half is okay, then copy half of the 
remaining original. If it isn’t okay, check 
the bottom half. Keep copying and past-
ing “halves” until you isolate the prob-
lem area, then deal with the problem.
• Use Recover Text from Any File.   
As a last resort, in the Open dialog box, 
set the Files Of Type dropdown list to 
Recover Text From Any File (*.*), and 

open the file. 
Delete all 
the gibberish 
at the end 
and save the 
remainder as 
a *.doc file. 
You’ll lose 
all format-
ting, but at 
least most 
of the text 
should be 
intact.

Figure A



3. Type the last part of the phrase—the 
final four numbers (4567) in our example. 
Notice that the non-breaking hyphen looks 
exactly the same as the regular hyphen. 

Enter optional hyphens
Many words can break in multiple 
places. For instance, you can break 
the word Halloween at any of these 
hyphens: Hal-low-een. If your com-
pany’s style guide specifies rules for 
hyphenation or you have your own 
personal preference, you’ll want to 
choose where a particular word should 
be hyphenated when it appears at the 
end of a line. You can do this by insert-
ing an optional hyphen. 
1. Type the first part of the word.
2. Press [Ctrl][-].
3. Finish typing the rest of the word. 
Although you probably won’t see the 
hyphen onscreen, the word breaks at the 
appropriate place if a break is necessary. 

View hidden hyphen formatting
If you want to view the optional hyphens 
as you type them, and you want to make 
the non-breaking hyphens appear differ-
ent from the regular hyphens onscreen, 
you have two options. 
• Click the Show/Hide button on 
the Standard toolbar. This shows the 
optional hyphens as well as other 
formatting marks, such as spaces and 
paragraph marks. The non-breaking 
hyphens look different from the regular 
hyphens onscreen. 
• If you don't want to see the format-
ting marks that Show/Hide displays, 
select Tools | Options | View. Select 
the Optional Hyphens check box in the 
Formatting Marks area, then click OK.  
We’ve juxtaposed these two methods in 
Figure A to help you compare.

Quickly create an eye-
popping chart from a 
simple table 
 
Although tables are effective tools 
for organizing and presenting 
numerical data, it’s easy to get lost 
in the sea of numbers they store. 
To make numerical data easier to 
digest at a glance, you can quickly 
transform a simple table into a 
chart, like the one in Figure A. 

Warning: If your table contains 
merged cells, this technique may 
produce unpredictable results. It's 
best to split merged cells before 
performing this technique.

To create a chart from a table:
1. Place the insertion point any-
where within the table, then 
choose Table | Select | Table from 
the menu bar to select it. 
2. Choose Insert | Picture | Chart 
from the menu bar. This launches 
the Microsoft Graph Chart mini 
application, which creates a new 
chart and datasheet based on the 
table data you selected earlier. 
3. Customize the chart as desired. 
4. When you’ve finished, click out-
side the chart object to return to 
your document. 

Force hyphens to follow your own style 
rules

QUICK TIPSQUICK TIPSQUICK TIPS
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If your document isn’t looking so 
neat, you can use hyphenation to 

increase the visual appeal of your doc-
uments. It helps you avoid unsightly 
gaps in justified text and it eliminates 
the overly ragged right margin in left-
aligned text. 

Initiate automatic hyphenation
You can easily request that Word 
hyphenate long words for you 
by choosing Tools | Language | 
Hyphenation from the menu bar. In 
the resulting Hyphenation dialog box, 
select the Automatically Hyphenate 
Document check box and click OK. 

Why can’t I turn on hyphenation? 
To use the automatic hyphenation fea-
ture, make sure it’s installed on your 
system. If the Hyphenation command 
doesn’t appear when you select Tools | 
Language from the menu bar, then you’ll 
need to run the Word or Office setup pro-
gram from the installation CD to install it.

Utilize non-breaking hyphens
Once you’ve set automatic hyphenation, 
you may realize that you don’t want 
certain hyphenated terms to break at 
the end of a line. For example, if you’d 
prefer that the phone number 123-4567 
not break to the next line between 3 and 
4, you can insert a non-breaking hyphen. 
This way, if the phone number is too long 
to fit on one line, Word moves the entire 
phone number to the next line. To insert a 
non-breaking hyphen:
1. Type the beginning of the hyphen-
ated phrase or string of characters. To 
follow with our example, type the first 
three numbers (123).
2. Instead of typing a regular hyphen, 
press [Ctrl][Shift][-]. 

Figure A

Figure A



ADVANCED WORD

Keep ‘em coming back for more with a frequent-buyer 
punch card

ADVANCED WORDADVANCED WORD
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You’ve probably heard that loyal 
customers and their repeat pur-

chases are the cornerstone of your 
long-term successful business. Why? 
Because it’s less costly to get your 
existing customers to buy more than 
it is to find new ones. One way to 
encourage your customers to return 
for more is with a frequent-buyer card 
that rewards the customer for multiple 
purchases. Punch cards, like the one 
shown in Figure A, not only bring 
your customer back repeatedly, they 
also serve as an advertisement or busi-
ness card. 

Add a little punch
Creating your own punch cards using 
Word is an economical way to advertise 
your business. You can create multiple 
punch cards with little effort using the 
Envelopes And Labels feature. 

Create the card sheet
An easy way to produce punch cards 
is to use the perforated business cards 
you can purchase at any office sup-
ply store. You can use one of Word’s 
business card label templates to set 
up your document. For our example, 
we’ll use Avery Laser Business Cards, 
product number 5371. The cards are 
laid out in two columns of five cards, 
and they separate easily after being 
folded back and forth along the perfo-
ration lines.

To set up your label sheet: 
1. Choose Tools | Letters And Mailings 
| Envelopes And Labels. 
2. In the Envelopes And Labels dialog 
box, select the Labels tab. 
3. Click the Options button to open the 
Label Options dialog box. 
4. Choose the type of product and the 
product number of the store-bought 
business cards you’re using. 
5. Click OK to return to the Envelopes 
And Labels dialog box. 
6. Click the New Document button. 
A new document opens with gridlines 
indicating the card layout. Now you’re 
ready to start designing your punch 
cards. 

No visible lines? If Word isn’t 
showing the boundaries of your punch 
cards at this point, choose Table | 
Show Gridlines from the menu bar to 
display them.

Illustrate your point with 
graphics 
We’ll place all of the elements of our 
punch card on the business card that 
appears in the top-left corner of the 
page. Later, we’ll copy everything to 
the other cards in the document. The 
first thing we’ll do is add a graphic to 
our punch card. You can use a graphic 
you already have on hand, such as a 
company logo.

Start off in the right place: Before 
you add a graphic to your punch card, 
make sure that the insertion point is 
positioned in the upper-left punch card 
on your label sheet. Word should auto-
matically position it there by default 
when you generate the label sheet, but 
if not, click in the first card’s area to 
move there. 

To insert a logo or other custom 
graphic: 
1. Choose Insert | Picture | From File 
from the menu bar to open the Insert 
Picture dialog box.
2. Locate and select your image, and 
then click Insert to add it to your 
punch card. Your document should 
now look similar to Figure B.

Logo alternatives: If you don’t have 
a custom graphic or logo that you’d 
like to use, you can use a clip art image 
instead. 

Size and place the image
If it isn’t already selected, click on the 
graphic to select it, and then use its siz-
ing handles to customize its size. You 
can also use the buttons on the Picture 
toolbar, such as the Crop button, to 
resize the image. To display the Picture 
toolbar, if it isn’t displayed already, 
choose View | Toolbars | Picture from 
the menu bar.

To reposition the graphic on 
the punch card: 
1. Select the graphic so its handles 
appear.
2. Click and drag it to the location 
you want it to appear on your punch 
card.
3. Use the rotate handle (the small 
green dot above the image) to tilt the 
graphic if desired.

Figure A
Figure B
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Add punch markers
Now, we’ll add the important punch 
markers that are indicative of frequent-
purchase cards. There are two ways to 
do so:
• Use one of the drawing tools, such as 
the Oval button, to create a small circle 
and format it using the Drawing toolbar.
• Use a small graphic by inserting it 
using the same technique we used to 
place our logo.

For our example, we’ll use a graphic 
that fits our card’s theme. Once you’ve 
drawn the circle or inserted the graphic, 
resize it if necessary, and position it 
where you want it on the punch card, as 
shown in Figure E.

To duplicate the first punch, select 
it and press [Ctrl]D to duplicate the 
image. Reposition the second image 
next to the original. Repeat for each 
punch marker you need. We duplicated 
our pumpkin image nine times, since 
our offer calls for 10 drinks. 

Scam alert! To avoid having a cus-
tomer add extra punches to his own 
card without making purchases, try 
using a specialty hole punch or ink 
stamper specific to your store. Thematic 
hole punches and ink stampers are 
available at most office supply stores.

Duplicate your efforts
Now that you’ve completed your 
punch card, we’ll group all of its ele-
ments and copy them onto the other 
blank business cards in the document. 
1. Select each item while holding 
down the [Shift] key, or click the Select 
Objects button on the Drawing toolbar, 
and then drag a selection box around 
your entire punch card. 
2. Click Draw on the Drawing toolbar 
and select Group. 
3. Press [Ctrl]D to duplicate the selec-
tion. 
4. Drag the duplicate selection on one 
of the blank punch cards on your label 
sheet and move it into place. 

Repeat these steps to complete all the 
cards on the label sheet. Now, simply 
print your cards on your card stock and 
you’re ready for some repeat business!

Say it with text boxes
You can add your company motto, 
address, phone number, and the punch 
card offer by using a few strategically 
placed text boxes. 
1. Display the Drawing toolbar by 
choosing View | Toolbars | Drawing 
from the menu bar, or click the Drawing 
button on the Standard toolbar. 
2. Click the Text Box button and draw a 
text box on your card. 
3. Click in the text box and enter your 
text, such as the name of your busi-
ness or your special offer, as we did in 
Figure C. 
4. Format your text as desired using dif-
ferent fonts, font sizes, and colors.

Add multiple text boxes, if necessary, 
to place your text exactly as you want it 
on the card.

To format the text box: 
1. Select a text box and choose Format 
| Borders And Shading from the main 
menu. 
2. On the Colors And Lines tab in the 
Format Text Box dialog box, choose No 
Fill from the Color dropdown menu in 
the Fill section to make your box trans-
parent. 
3. Select No Line from the Color drop-
down menu in the Line section. 
4. Click OK to return your document. 
Repeat these steps for each text box 
to remove any unwanted borders and 
backgrounds, as shown in Figure D.

Figure C

Figure D

Figure E
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A     Your AutoText entries, which are 
stored in templates, may be in your 

Normal.dot template, in a special custom 
template, or scattered throughout a vari-
ety of templates on your system. 

I suggest that you create a template 
just for the AutoText entries that you 
want to share, and copy the entries  
to that template. You might even use the 
“document” portion of the template to 
include transfer instructions and a list of 
each AutoText entry, along with helpful 
details about when and where to use it.

Choose File | New, and then click on 
the General tab. (In 2002, select General 
Templates in the task pane.) Select Blank 
Document in the Templates dialog box 
and select the Templates option but-
ton in the Create New panel, then click 
OK. Save the new template and name it 
SharedAutoText.dot.

Choose Tools | Templates And Add-ins, 
then click the Organizer button. The list 
on the right probably shows the names of 
the AutoText entries in Normal.dot. Select 
the one(s) you want to transfer and click 
<<Copy, as shown in Figure A. 

Next, under the Normal.dot list, click 
Close File, then choose the same button 
which now says Open File. Open another 
template that contains AutoText entries that 

Give easy access to your 
AutoText entries with a template

Help users differentiate between
zeros and capital Os

Q I need to print serial numbers that 
contain both alphabetic and numeric 

characters. How can I put a slash through each 
zero to distinguish it from the uppercase O?

A You can use a Word equation field 
to create a slashed zero or find a 

font with that character.
• Create the slashed zero.  Set the inser-
tion point where you want the slashed 
zero, then press [Ctrl+F9] and set up 
this field: {EQ \o (0,/)}  The \o () 
overstrike switch tells Word to print 
each character that you listed within the 
parentheses in the same space.

Once you create the character in the 
font that you typically use, you can save 
it as an AutoText entry. If you’ll use it 
often, you can create a macro to set up 
the field and then assign that macro to a 
keystroke.
• Install a slashed zero font.  If you type 
hundreds of slashed zeroes, you may 
prefer to search online for a font that 
contains that character. As you consider a 
font, also check to see that the lowercase l 
and uppercase I are distinctly different.

As of this writing, Seagull Scientific, 
Inc. (www.seagullscientific.com/aspx/slash_
0.aspx) offers their Crystal font for free 
download that meets the slashed zero and 
I/l criteria.

Figure A

Easily change the contents of 
your document's Properties

A There is a way to stop guessing the 
dimensions of your text boxes.

Highlight the text you want to put in a 
text box (you must type the text before 
you insert the text box), and select Insert | 
Text Box from the menu bar. Word inserts 
the highlighted text in a perfectly fitted 
text box. Once you insert the text box in 
this manner, you can format it as desired.

Q I’ve developed many “boilerplate” 
entries over the years. Now that 

we’re trying to standardize some of our cus-
tomer responses, how can I share these entries 
with my coworkers?

Q I use a lot of text boxes, but I find 
myself fussing with their borders, so 

they don’t take up more room than they need 
to. Is there an easy way to make a text box that 
automatically fits its contents?

A Yes, you can create a custom property 
to reflect your company name. In the 

open document (or template), choose File | 
Properties, then click on the Custom tab. In 
the Name list box, select Department. Note 
the options in the Type dropdown list, and 
accept Text. In the Value text box, type the 
department name, such as Sales—it must 
match the value in the Type dropdown 
list. Click Add. Department is now in your 
Properties list. Click OK and save the file.

The Department property will now 
display in the Open dialog box’s Proper-
ties view and will be included when you 
print the document’s properties.

To insert it in the document via a field, 
choose Insert | Field. Choose Document 
Information from the Categories drop-
down list and choose DocProperty from 
the Field Names list box, then click the 
Field Codes button. (In 2002, choose Field 
Codes from the Field Names dropdown 
list.) Click in the Field Codes box after 
DOCPROPERTY and replace the current 
entry with "Department"—be sure to 
include the quotation marks. Click OK.

Q Is there a way to enter the name of 
our department in the Properties 

dialog box?

Create perfectly sized text 
boxes in a snap

you want to copy, and copy them. Repeat 
as needed until you have all the necessary 
AutoText entries copied from their respec-
tive templates to your SharedAutoText.dot. 
Finally, close the Organizer.

Add any text you wish to the 
SharedAutoText template, save and close 
it, and then distribute it to your colleagues. 
They can then use Organizer to move the 
AutoText entries to whatever templates 
they wish on their own computers.



You're writing a letter and need 
to insert the curent date, but you 

can't recall what the date is. Or, you 
don't want to format the date after you 
type it. Fortunately, Word offers sev-
eral choices when inserting the current 
date into a document, including: 
• The Date And Time dialog box. 
This inserts a static line of text with 
the current date. 
1. Place the insertion point in the 
document where you want the date 
inserted. 
2. Choose Insert | Date And Time.
3. In the Available Formats list box, 
choose the desired date format. 
4. Select the Update Automatically 
check box and click OK. 
• A Date field code. This inserts an 
automatically updating field with the 
current date. 
1. Place the insertion point where you 
want the date to appear. 
2. Choose Insert | Field. 
3. Select Date And Time from the 
Categories dropdown list to display 
the available fields. 
4. From the Field Names list box, 
select Date. 
5. In 2002/2003, select the format in 
the Date Format list box to see the 
field codes. In 2000, click the Options 
button in the Field dialog box. Select a 
date format, click Add To Field, then 
click OK twice.
• An AutoText entry. This allows you 
to insert the field code without access-
ing any dialog boxes. 
1. Insert the Date field code in your 
document using the Insert | Field 
command. 
2. Select the date format and click OK. 
3. Select the field and press [Alt][F3] to 
save it as a new AutoText entry. 
4. Name the entry and click OK. 

To use the date AutoText entry:
1. Place the insertion point where you 
want the date to appear.
2. Type the name of the AutoText 
entry and press [F3].
 

3 easy ways to 
insert the current 
date

 

Your document is your canvas 
when you know the Draw menu

How well do you know the options on the Draw menu located on the 
Drawing toolbar? Take our quiz to test your knowledge, then let 

your creativity shine!

Draw menu commands
A) Group E) Grid         I) Text Wrapping
B) Ungroup F) Nudge                              J) Reroute Connectors
C) Regroup G) Align Or Distribute      K) Edit Points
D) Order H) Rotate Or Flip      L) Change AutoShape
         M) Set AutoShape Defaults
                        
Draw menu actions
____ 1. Changes the points on an AutoShape, altering its design.
____ 2. Changes which object is in the foreground or background  
 when you have multiple objects.
____ 3. Moves an object in small increments, such as Up or Left.
____ 4. Wraps text around an object so that both the text and object  
 are visible, e.g., Behind Text, In Line With Text.
____ 5. Makes multiple objects become one object.
____ 6. Allows you to choose a different AutoShape. 
____ 7. Displays gridlines within your object.
____ 8. Makes multiple grouped objects separate again.
____ 9. Changes the way your object displays, i.e., Vertical or Horizontal.
____ 10. Gives your AutoShape default settings.
____ 11. Determines how your objects line up. 
____ 12. Changes the way your object's connectors display.
____ 13. Makes multiple objects a single object again. 

Need to boost your confidence and productivity in other  
Microsoft applications? Try these titles to find out how.

FOR INFORMATION, CALL 1-800-424-8668
http://www.oootraining.com/ws/

TEST YOUR PC IQ

q
q

q Microsoft Excel Microsoft Outlook
Microsoft Word MS Excel for Advanced Users
Microsoft PowerPoint Microsoft Office

q
q

q
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Answers
1 - K, 2 - D, 3 - F, 4 - I, 5 - A, 6 - L, 7 - E, 8 - B, 9 - H, 10 - M, 11 - G, 12 - J, 13 - C
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There’s nothing more frustrating then 
waiting for photos or graphics to load 

while you hurriedly scroll through a 
document. You may even encounter an 
error if your system can’t keep up. And, 
if your company has email file size limits 
in place, you may not be able to send a 
document if the images are taking up too 
much disk space. Word understands these 
issues and has a simple way to overcome 
them—the Compress Pictures feature.

Expand your compression 
options
All image compression happens via the 
Compress Pictures dialog box. By using 
this feature, you can greatly reduce your 
document’s file size without drastically 
altering its appearance. 

To begin, click on one of the images 
in your document to make the Picture 
toolbar visible. Click the Compress 
Pictures button on the Picture toolbar 
to open the Compress Pictures dialog 
box, as shown in Figure A. For now, 
close the dialog box. We’ll come back to 
it after we’ve chosen which images to 
compress.

Where’s my Picture toolbar? If 
your Picture toolbar doesn’t display 
automatically when you click on an 

image, select View | Toolbars. Select 
Picture from the resulting list.

One or many images
When you compress images, you have 
the option to compress all images at once, 
or take care of one or more individually 
selected images.
• To compress every image in your 
document, click on any image, click the 
Compress Pictures button, and select the 
All Pictures In Document option. 
• To compress just one picture, click on 
the image, click the Compress Pictures 
button, and choose the Selected Pictures 
option button. 
• To compress multiple selected images, 
select the graphics, click the Compress 
Pictures button, and choose the Selected 
Pictures option button.

Pick and choose your graphics
To select multiple pictures, you may need 
to set the image wrapping options (on the 
Picture toolbar) for each picture to some-
thing other than In Line With Text. Doing 
so converts the pictures into floating 
images. You can select multiple images in 
one of two ways: 
• Hold down [Ctrl] or [Shift] and click on 
the pictures you’d like to select. 
• Click the Select Objects button on the 
Drawing toolbar and draw a box around 
all the objects you’d like to select. Now 
that your pictures are selected, you're 
ready to compress them. 

Define the compression options
In the Options panel of the Compress 
Pictures dialog box, two check boxes are 
selected by default, but you can change 
those selections to meet your needs. 

• If you only want to compress the 
picture(s), deselect the Delete Cropped 
Areas Of Pictures check box. 
• If you only want to delete the cropped 
areas of the picture(s), deselect the 
Compress Pictures check box. 
• If you want to severely reduce the file 
size of a document, we recommend leav-
ing both options selected. 

Crop carefully! If you think you 
may need to re-crop an image, wait until 
you’re completely satisfied with your 
document before selecting the Delete 
Cropped Areas Of Pictures option. Once 
you crop an image and choose this selec-
tion, the changes are permanent. 

Finally, select one of the options in 
the Change Resolution panel. 
• Select the Web/Screen option button 
to substantially reduce the file size of 
a document. For example, by selecting 
this option, we reduced the file size of a 
document by 500 KB. 
• If you plan to print your document, 
select the Print option button. However, 
selecting this option will likely reduce 
the file size only slightly. 

You may want to experiment to find 
the option that balances your image 
quality and file size needs the best. 

Finalize the compression
Once you select all the necessary options, 
click the OK button to compress the pic-
tures in your document. When you do, 
a dialog box appears warning you that 
compressing the pictures in your docu-
ment may reduce the quality of your 
images. Click Apply to compress your 
pictures. 

Figure A


